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Le numéro de série est situé sur le panneau arrière de l'unité. Nous vous conseillons de noter le 
numéro de série dans l'espace fourni ci-dessous. Indiquez-le à chaque fois que vous vous mettez en 
contact avec un réparateur Apogee Electronics agréé ou le fabricant. Assurez-vous de bien retourner 
votre bon de garantie dès maintenant !

Nº série de l'Ensemble___________________________________________________

Date d'achat__________________________________________________________
 
Vendeur_________________________________________________________________

Téléphone_________________________________________________________________

Adresse________________________________________________________________

ATTENTION :
Tous les changements ou modifications sans autorisation exprès d'APOGEE ELECTRONICS 
CORPORATION peuvent annuler votre droit à utiliser cet équipement selon les normes FCC.

Veuillez enregistrer cette unité en remplissant la carte d'enregistrement fournie ou en ligne à
http://www.apogeedigital.com/support/register.php Veuillez lire ce manuel - si vous appelez 
le service technique, nous considérerons que vous l'avez fait. Il y aura un questionnaire.

Enregistrement du propriétaire
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Introduction

Ensemble est une interface audio Firewire contrôlée numériquement conçue spécialement pour les 
ordinateurs Macintosh d'Apple. Des préamplis micro à la connectivité Mac Core Audio en passant par les 
sorties casque, Ensemble inclue tout ce qui est nécessaire pour un système d'enregistrement à base Mac 
de haute qualité.

Ensemble inclue plusieurs technologies Core d'Apogee, comme :

SoftLimit 

Soft Limit est un circuit de limitation des crêtes analogique qui contrôle instantanément et élégamment les 
crêtes transitoires, offrant par conséquence 4 dB supplémentaire d'headroom. Soft Limit peut être activé 
sur les 8 entrées analogiques d'Ensemble.

UV22HR 

UV22HR est l'algorithme de dither (tramage) standard dans l'industrie d'Apogee pour réduire la longueur 
des mots du signal audio numérique de 24 à 16 bits. UV22HR est aussi utilisé pour produire un contenu 
audio pour internet et les ordinateurs nettement amélioré sans pour autant augmenter la taille des fichiers 
ou les taux de données. 

Sample Rate Conversion (SRC) d'Apogee

La conversion de la fréquence d'échantillonnage matériel d'Ensemble fournit une solution flexible et de 
grande qualité pour travailler avec du matériel et des logiciels audionumérique tournant à des fréquences 
d'échantillonnage différentes. La conversion de la fréquence d'échantillonnage d'Ensemble peut être 
appliquée à une entrée numérique (pour convertir un flux entrant à la fréquence d'échantillonnage 
d'Ensemble) ou à une sortie numérique (pour fournir un flux sortant à une fréquence d'échantillonnage 
choisie par l'utilisateur, différente de celle d'Ensemble).

Configuration requise pour Ensemble

1.	Apple PowerMac 1,5 GHz ou supérieur, 512 Mo de RAM minimum, 1 Go recommandé
2. 	OS X 10.4.11 ou 10.5 et supérieur ; OS X 10.5.3 ou supérieur chaudement recommandé
3.	Apple Logic Pro 7.2.3 ou 8.0 et supérieur
4. 	Un câble Firewire 400

Remarque importante :
Le fonctionnement décrit dans ce Manuel de l'utilisateur est basé sur la version 1.3
du firmware et du software d'Ensemble, distribués en février 2007.
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Démarrage rapide

1. Installation du logiciel
	 Insérez le CD inclus dans votre lecteur optique, 

double-cliquez sur l'icône de l'Ensemble Software 
Installer et suivez les indications du programme 
d'installation qui s'affichent à l'écran. Une fois 
l'installation terminée, il sera nécessaire de 
redémarrer votre Mac.

2. Connexions matérielles
	 En utilisant le câble FireWire livré, branchez l'un 

des ports FireWire de l'Ensemble sur l'un des 
ports FireWire 400 de votre Mac (illustration 2).

	

	

	 Branchez la prise d'alimentation de l'Ensemble 
sur une prise CA de 90 à 250 volts ; le témoin 
d'alimentation de l'Ensemble s'allume pour 
indiquer l'alimentation. Pressez l'interrupteur 
d'alimentation pour allumer l'unité (illustration 3).

	 Branchez une paire d'écouteurs sur la sortie 
	      1 de l'Ensemble (illustration 4). 

illustration 1

illustration 2

illustration 3

illustration 4
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3. Configuration d'OS X
	 Depuis la barre de menus de votre Mac d'Apple, 

ouvrez la fenêtre des Préférences système, 
puis cliquez sur l'icône son (illustration 5).

	

	
	 Dans la fenêtre des Préférences sonores, 

cliquez sur l'onglet Sortie et sélectionnez 
Ensemble (illustration 6).

	

illustration 5

illustration 6

4. Lecture iTunes
	 Ouvrez iTunes, sélectionnez un fichier audio et 

lancez la lecture (illustration 7).

	 Pressez le bouton rotatif OUTPUT jusqu'à ce 
que le témoin      1 s'allume et réglez le niveau 
dans vos écouteurs (illustration 8).

	

illustration 7

illustration 8

Démarrage rapide
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Démarrage rapide

5.  Configuration DAW
	 Configurez votre logiciel compatible Core Audio 

pour communiquer avec les E/S matérielles 
d'Ensemble. 

	 Par exemple, dans Logic 8 Pro :

	 Choisissez Préférences > Audio et cliquez sur 
l'onglet Dispositifs. Dans la fenêtre Dispositifs, 
cliquez sur l'onglet Core Audio (illustration 9).

	

	 Cochez la case Activé, sélectionnez Ensemble 
dans le champ Dispositif et vérifiez que la case 
Enregistrement 24 Bit est cochée. Cliquez sur 
Appliquer les changements quand vous avez 
terminé (illustration 10).

	

	 Pour "personnaliser" les étiquettes de routage des 
E/S dans Logic de sorte qu'elles correspondent à 
celles du matériel Ensemble, choisissez 

	 Options > Audio > Étiquettes E/S. Cliquez sur le 
cercle près de chaque étiquette sous la colonne 
Fourni par le pilote (illustration 11).

	 Pour contrôler Ensemble directement depuis votre 
session Logic, choisissez Options > Audio > 
Ouvrir le Panneau de configuration d'Apogee 
(illustration 12).

	 Si vous utilisez une application logiciel audio 
compatible Core Audio, utilisez le logiciel 
Maestro d'Apogee (installé dans votre dossier 
Applications lors de l'Étape 1) pour contrôler 
Ensemble.

	

illustration 9

illustration 10

illustration 11

illustration 12
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6. Enregistrement 	
	 Branchez un micro sur la prise arrière MIC 1 

(illustration 13) 

	
	
	 ou un instrument sur la prise en façade HI–Z 1 

(illustration 14).

	

	 Dans Logic, configurez une entrée de piste 
sur Analog 1 et sa sortie sur Analog 1/2 puis 
activer la piste pour l’enregistrement  
(illustration 15). 

	 Pressez le bouton rotatif INPUT en façade 
jusqu'à ce que le témoin Pre 1 s'allume puis 
tourner le bouton pour obtenir un niveau 
d'enregistrement correct sur la piste activée 
pour l'enregistrement (illustration 16).

	   
      Vous êtes prêt à enregistrer !

illustration 13

illustration 15

Démarrage rapide

illustration 16

illustration 14
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Effectuez les réglages avec les panneaux de configuration logiciel

Tous les paramètres d'Ensemble sont réglables depuis le panneau Settings du logiciel Maestro d'Apogee ou le 
Panneau de configuration d'Apogee dans Logic Pro. Certains réglages peuvent aussi être effectués depuis les 
panneaux de configuration audio d'OS X. Il est possible d'ouvrir plusieurs panneaux de configuration à la fois, 
étant donné que les réglages faits dans un panneau sont automatiquement reportés sur les autres. De plus, le Mic 
Pre Gain et l’Output level peuvent être contrôlés depuis les boutons en façade d'Ensemble, comme décrit dans la 
moitié inférieure de cette page. 
	
Qu'est-ce que Maestro ? - Apogee Maestro fournit le contrôle le plus complet d'Ensemble, incluant le contrôle de 
tous les paramètres d'Ensemble, le stockage/rappel des configurations, le routage étendu et 2 mélangeurs à faible 
latence. Maestro peut être utilisé 	avec n'importe quelle application audio compatible Core Audio. Veuillez-vous 
reportez à l'explication complète du panneau Réglages de Maestro à partir de la p. 14.

Le Panneau de configuration Apogee pour Logic Pro, dans le menu Audio de ce dernier, fournit un contrôle de 
tous les paramètres pour Ensemble et le stockage/rappel des configurations.

Audio Midi Setup (AMS) – Cet utilitaire d'OS X (dans le dossier racine/Applications/Utilitaires) fournit le contrôle 
sur la fréquence d'échantillonnage, le niveau de sortie et la source d'horloge d'Ensemble. 

Pour régler le niveau de sortie d'Ensemble via le curseur audio du menu du Mac, réglez Default Output (dans 
AMS) pour Ensemble ; les curseurs audio d'OSX (le curseur de la barre menu inclus) contrôlent alors la sortie 
sélectionnée sur la façade d'Ensemble. Par exemple, si le témoin  1 en façade s'allume, les curseurs audio 
d'OSX contrôlent le niveau de sortie  1.

Effectuer les réglages avec les boutons en façade d'Ensemble

Les boutons en façade d'Ensemble fournissent un accès simple et immédiat aux réglages de Mic Pre gain et aux 
niveaux de sortie. 

Pour utiliser le bouton gauche pour contrôler le mic pre gain :

	 Sélectionnez le mic pre gain à régler en cliquant le bouton rotatif gauche jusqu'à ce que le témoin PRE
	 désiré s'allume.
	 Faites tourner dans le sens des aiguilles d'une montre pour augmenter le gain ou dans le sens inverse 
	 pour le réduire.
	 Les témoins qui entourent le bouton indiquent sa "position", vous fournissant ainsi une indication visuelle 		
	 rapide du niveau comme le ferait un bouton traditionnel.

Pour utiliser le bouton droit pour contrôler les niveaux de sortie :

	 Sélectionnez la sortie à régler en cliquant le bouton rotatif gauche jusqu'à ce que le témoin désiré s'allume 
	 puis tourner le bouton comme décrit précédemment ; en sélectionnant MAIN, les niveaux des sorties 
	 analogiques arrières peuvent être réglés ; en sélectionnant   1 ou   2, le niveau de la sortie casque en 
	 façade correspondante peut être réglé.

	 En pressant et maintenant enfoncé le bouton rotatif droit pendant quelques secondes, toutes les sorties 
	 analogiques sont rendues muettes. Le témoin de la sortie sélectionnée clignote pour indiquer la 
	 désactivation.

Veuillez-vous reportez à la p. 16 pour configurer les sorties MAIN et casque

Fonctionnement général
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Réglage de la fréquence d'échantillonnage

Pour régler la fréquence d'échantillonnage d'Ensemble, choisissez la fréquence choisie dans votre 
application logiciel audio compatible Core Audio ; Ensemble s'adaptera tout seul. Si l'application n'a 
pas de réglage de la fréquence d'échantillonnage, ouvrez l'utilitaire de configuration midi audio d'OSX, 
sélectionnez Ensemble dans le champ Propriétés pour et sélectionnez la fréquence désirée dans le 
champ Format.

Utilisation des fréquences d'échantillonnage 176.4–192 kHz

Pour utiliser Ensemble à la fréquence d'échantillonnage de 176.4-192k, il est nécessaire de régler l'option 
I/O Allocation (dans Maestro sous Tools>Settings> Settings) pour choisir 10x10 ou 8x8. Étant donné 
que les E/S optiques ne sont pas compatibles avec ces fréquences d'échantillonnage, les chemins 
Firewire connexes sont désactivés pour économiser la bande passante processeur. 
Après avoir modifié l'option I/O Allocation, il est fortement recommandé de redémarrer l'ordinateur et 
d'éteindre et rallumer Ensemble.

Réglage de la source d'horloge

La source d'horloge d'Ensemble peut être réglée depuis Maestro, le panneau de configuration Apogee de 
Logic Pro ou l'utilitaire de réglage midi audio d'OSX.

Quand Ensemble est verrouillé sur une source externe, la fréquence d'échantillonnage d'Ensemble est 
toujours déterminée par la sélection dans le logiciel. Par conséquent, la fréquence d'échantillonnage de la 
source externe doit être configurée manuellement pour correspondre à celle du logiciel. Par exemple, si 
vous souhaitez ouvrir une session à 88.2 kHz mais que vous verrouillez Ensemble sur la word clock d'un 
Big Ben Apogee, vous devez régler manuellement le Big Ben sur 88.2 kHz.

E/S numériques

La disponibilité des E/S numériques d'Ensemble dépend de la fréquence d'échantillonnage et du réglage 
du Optical I/O Format, comme décrit dans le tableau ci-dessous.

Mode autonome

Quand la connexion firewire d'Ensemble est interrompue, l'unité entre automatiquement en mode 
autonome. Les réglages du panneau de configuration, de routage et du mélangeur restent les mêmes, et ce 
même en l'absence d'un ordinateur hôte. En mode autonome, les témoins d'état passent au vert et toutes 
les commandes de façade restent actives.

Routage d'Ensemble

À moins que le routage ne soit modifié dans le logiciel Maestro, toutes les entrées arrières de l'Ensemble 
sont routées via Firewire vers le Mac, alors que les sorties arrières sont routées via Firewire depuis le Mac, 
comme décrit dans les deux prochaines pages. 

E/S 
analogiques

E/S 
optiques

E/S 
coaxiales

Total

44.1k/48k 8 8 ADAT ou 2 S/PDIF 2 18
88.2k/96k 8 4 SMUX ou 2 S/PDIF 2 14

176.4k/192k 8 [aucune] 2 10

Fonctionnement général
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18 DAW Inputs18 Hardware Inputs 

F
ire

W
ire

 O
ut

pu
t

Analog 1

Analog 2

Analog 3

Analog 4

Analog 5

Analog 6

Analog 7

Analog 8

S/PDIF (coax) L

S/PDIF (coax) R

ADAT 1

ADAT 2

ADAT 3

ADAT 4

ADAT 5

ADAT 6

ADAT 7

ADAT 8

Fonctionnement général

Schéma de routage des entrées
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18 DAW Outputs

F
ire

W
ire

 In
pu

t

18 Hardware Outputs

Analog 1

Analog 2

Analog 3

Analog 4

Analog 5

Analog 6

Analog 7

Analog 8

S/PDIF (coax) L

S/PDIF (coax) R

ADAT 1

ADAT 2

ADAT 3

ADAT 4

ADAT 5

ADAT 6

ADAT 7

ADAT 8

Fonctionnement général

Schéma de routage des sorties
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Contrôle Maestro : Réglages - Réglages

Tous les paramètres d'Ensemble sont effectués depuis le panneau Settings du logiciel Maestro d'Apogee ou 
le Panneau de configuration d'Apogee dans Logic Pro. Si vous utilisez Logic Pro, veuillez-vous reporter à la 
description du panneau de configuration Apogee dans la documentation de Logic Pro. 

Sélection de l'unité - Quand plusieurs dispositifs Apogee sont reliés à l'ordinateur, cette sélection indique celui qui 
sera contrôlé par Maestro.

Identification de l'unité – Quand elle est cochée, tous les témoins sur la façade d'Ensemble s'allument, 
permettant ainsi d'identifier le matériel qui reçoit les réglages du panneau de configuration du logiciel.

Sélection de la source d'horloge – Ce menu déroulant est utilisé pour régler la source d'horloge d'Ensemble sur 
Internal ou sur les entrées arrière S/PDIF Coax, Optical ou Word Clock. 

Sélection SRC – La conversion de la fréquence d'échantillonnage est appliquée sur le chemin stéréo sélectionné 
dans ce menu déroulant. Lors de la conversion de l'entrée numérique (à n'importe quelle fréquence) à la fréquence 
d'échantillonnage d'Ensemble (et par conséquent de la session DAW), applique la conversion de la fréquence 
d'échantillonnage sur l'entrée numérique.

Fréquence SRC – Lors de la conversion de la sortie de la session DAW à une autre fréquence d'échantillonnage, 
applique la conversion à la sortie numérique (sous Sélection SRC) et sélectionnez la fréquence souhaitée dans le 
menu déroulant fréquence SRC.

UV22HR – L'UV22HR est appliqué sur le chemin stéréo sélectionné dans ce menu déroulant. L'UV22HR devrait 
être appliqué sur les entrées analogiques et numériques lors de l'enregistrement d'une session 16-bit et appliqué 
sur les sorties numériques lors du routage des signaux d'Ensemble vers les dispositifs numériques 16-bit telles 
que les graveurs CD externes ou les enregistreurs DAT. L'UV22HR est uniquement disponible aux fréquences 
d'échantillonnage de 44.1k – 48k, étant donné que les formats de fréquence supérieurs et les dispositifs ne sont 
compatibles qu'avec le fonctionnement 24 bit.

Allocation des E/S – Dans ce menu déroulant, il est possible d'allouer le nombre de canaux disponibles via 
les E/S Firewire. Lorsque vous utilisez des ordinateurs hôtes plus lents et/ou des fréquences d'échantillonnage 
supérieures, l'allocation d'un nombre inférieur de canaux aux E/S Firewire permet de réduire le nombre de 
ressources processeur utilisées pour la communication Firewire. Veuillez remarquer que lorsque l'allocation 18 
x 18 est sélectionnée, la fréquence d'échantillonnage la plus importante est 96 kHz. De même, toutes les E/S 
matériel peuvent être routées via les E/S Firewire disponibles dans les pages de routage de Maestro.

Bande passante utilisée – Cet indicateur mesure le pourcentage de bande passante utilisée par tous les 
dispositifs AUDIO Firewire reliés au bus firewire interne du Mac. La bande passante utilisée par les disques durs 
n'est pas inclue. Si l'indicateur montre 100%, sélectionnez un paramètre d'allocation des E/S inférieur. 

Entrée optique – Dans ce menu déroulant, configurez le format numérique de l'entrée optique arrière sur S/PDIF ou 
ADAT/SMUX.

Sortie optique – Dans ce menu déroulant, configurez le format numérique de la sortie optique arrière sur S/PDIF 
ou ADAT/SMUX.

Affichage de l'indicateur – Le signal affiché par les indicateurs en façade peut être réglé dans ce menu 
déroulant. Les réglages disponibles sont Off (les indicateurs n'affichent aucun signal), Input (les indicateurs 
affichent les entrées d'Ensemble) ou Output (les indicateurs affichent les sorties d'Ensemble)

Sortie Word Clock – La fréquence de la sortie word clock peut être configurée dans ce menu déroulant de façon 
à correspondre à celle de l'unité (WC x 1) ou à la moitié de celle-ci (WC x 1/2) pour s'adapter aux dispositifs reliés. 
 
Mode CD – En cochant cette case, vous envoyez un signal stéréo 44.1k, 16–bit sur la sortie S/PDIF Coax, 
quelque soit la profondeur de bits ou la fréquence d'échantillonnage de la session DAW. Le mode CD configure 
l'UV22HR vers la S/DPIF Out et si la session DAW est à une autre fréquence d'échantillonnage que 44.1k, 
configure la SRC Select sur la S/PDIF Out et la SRC Rate sur 44.1k.

Maintenir les crêtes – En cochant cette case, les indicateurs de crêtes rouges sur les indicateurs en façade et 
dans la page Settings/Output de Maestro restent allumés tant que le bouton Clear Meters (Effacer les indicateurs) 
n'est pas pressé (dans la fenêtre Mixer de Maestro).

Réglages des entrées : Soft Limit – Lorsqu'elle est cochée, la protection à la surcharge Soft Limit d'Apogee est 
activée sur l'entrée analogique correspondante.

Réglages des entrées : +4, –10, MIC – Le niveau de référence nominale de chaque entrée analogique est 
sélectionné avec ces boutons de radio. Les entrées 1–4 peuvent aussi être réglées sur le niveau MIC, permettant 
de régler le gain de +10 à +75 dB.

Réglages de sortie – Le niveau de référence nominal de chaque sortie analogique est sélectionné avec ces 
boutons de radio.
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Contrôle Maestro : Réglages - Réglages (schéma)
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Contrôle Maestro : Niveaux - Sortie

Contrôle du niveau – Trois boutons fournissent le contrôle du niveau pour les sorties Main, HP1 et HP2. 
L'atténuation de sortie de 0 à –127 dB est affichée dans une lecture correspondante. 

Affichage de l'indicateur – Le signal présent sur n'importe quel canal sélectionné dans les listes déroulantes 
Sélection du format MAIN ou Sélection de la source HP 1–2 est affiché dans l'indicateur correspondant.

Sélection du format MAIN – Cette liste déroulante est utilisée pour configurer les sorties analogiques dans diverses 
situations de suivi. 

	 Quand Format est réglé sur Aucun, toutes les sorties analogiques fonctionnent en tant que sorties 
	 de ligne standard ; le curseur de niveau Main n'a aucune fonction.

	 Quand Format est réglé sur Stéréo, le curseur de niveau Main (et le bouton Output en façade) contrôle 
	 le niveau des Sorties analogiques 1–2. Les sorties 3–8 fonctionnent en tant que sorties de ligne standard.

	 Quand Format est réglé sur 5.1 surround, le curseur de niveau Main (et le bouton Output en façade) 
	 contrôle le niveau des Sorties analogiques 1–6. Les sorties 7–8 fonctionnent en tant que sorties 
	 de ligne standard.

	 Quand Format est réglé sur 7.1 surround, le curseur de niveau Main (et le bouton Output en façade) 
	 contrôle le niveau de toutes les Sorties analogiques.

Sélection de la source HP1 HP2 – Ces listes déroulantes sont utilisées pour sélectionner la source du signal stéréo 
sur les sorties casque en façade.

1

2

3

4

Contrôle Maestro : Niveaux - Entrée

Pre1 – Pre4 – Les contrôles suivants sont fournis pour Pre1–Pre4

Contrôle du gain – Ce bouton fournit un contrôle de gain pour le mic pre. Le Mic pre gain de +10 à +75 dB 
s'affiche dans la lecture correspondante. 

Affichage de l'indicateur – Cet indicateur affiche le niveau de conversion du canal correspondant, pour 
une référence pratique lors du réglage du mic pre gain.

Groupes – Le contrôle du gain de deux ou davantage de Pres peut être relié en sélectionnant le même 
groupe dans la liste déroulante. Le décalage du gain présent quand les Pres sont groupés est conservé 
après le regroupement.

Phase – Quand cette case est cochée, la polarité de l'entrée analogique correspondante est inversée.

48V – Quand cette case est cochée, une alimentation fantôme de 48 volts est appliquée sur l'entrée XLR 
correspondante.

SoftLimit – Quand cette case est cochée, la protection de surcharge Soft Limit est appliquée sur l'entrée 
analogique correspondante.

1

2

3

4

5

6
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Contrôle Maestro : Niveaux - Sortie (schéma)

Contrôle Maestro : Niveaux - Entrée (schéma)
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Préférences de Maestro
Les préférences suivantes de Maestro déterminent le comportement du matériel connecté. Veuillez consulter le 
Manuel de l'utilisateur de Maestro pour en savoir plus sur ces préférences logiciel.
 
Lancement automatique de Maestro lors du branchement d'un dispositif
Quand cette case est cochée, Maestro se lance automatiquement quand Ensemble est détecté sur le bus firewire 
du Mac.

Autoriser les pop-ups
Quand cette case est cochée, les pop-ups des boutons apparaissent sur le bureau Mac quand les boutons en façade 
sont manipulés. Les pop-ups affichent divers paramètres d'Ensemble comme la sélection des entrées et des sorties, 
les niveaux, les groupes d'entrées et la désactivation des sorties. Pour vous expliquer, voici quelques exemples :

Pre1 sélectionné en entrée

bouton réglé sur 38 dB

Pre3-Pre4 groupés et sélectionnés en entrée

bouton 3 réglé sur 40 dB

bouton 4 réglé sur 50 dB
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Préférences de Maestro

Analog (Main) sélectionné en sortie

bouton réglé sur -60 dB

HP2 sélectionné en sortie

bouton réglé sur 0 dB



En parcourant la façade

1. 	 Interrupteur d'alimentation – Pressez ce bouton pour alimenter l'Ensemble. Quand la prise d'alimentation 
d'Ensemble est branchée, l'interrupteur s'allume pour indiquer que l'unité est en attente.

2. 	 STATUS – Ce témoin multi-couleur offre une indication visuelle rapide de l'état de divers paramètres.

• 	 Un témoin bleu indique que l'Ensemble est verrouillé sur la source d'horloge dans le contrôle 
logiciel et que la connexion Firewire este valide.

•	 Un témoin clignotant indique qu'Ensemble n'est pas verrouillé sur la source d'horloge 
sélectionnée.

• 	 Un témoin rouge indique qu'Ensemble n'a pas réussi la connexion Firewire valide. Après un 
moment, Ensemble bascule en mode autonome.

•	 Un témoin vert indique qu'aucune connexion firewire n'est présente et qu'Ensemble fonctionne en 
mode autonome.

• 	 Un témoin rouge clignotant indique que les deux conditions d'erreur sont présentes.

3. 	 HI–Z Entrée 1-2 - Ces connecteurs 1/4" acceptent des sources de grande impédance telles que les 
claviers et les guitares. Quand un jack est inséré dans un connecteur Hi–Z, le connecteur XLR d'entrée 
est désactivé.

 	 Bouton rotatif INPUT – Quand les entrées 1 à 4 sont configurées pour utiliser le contrôle logiciel, ce 
bouton contrôle le mic pre gain ; pour sélectionner l'entrée contrôlée, pressez le bouton rotatif jusqu'à ce 
que le témoin PRE désiré s'allume ; faites tourner le bouton dans le sens des aiguilles d'une montre pour 
augmenter ou dans le sens inverse pour réduire le niveau. Les témoins qui entourent le bouton indiquent 
sa "position", vous fournissant ainsi une indication visuelle rapide du niveau comme le ferait un bouton 
traditionnel. Si aucune entrée n'est configurée pour le Micro dans le contrôle logiciel, le bouton n'a pas 
de fonction.

5. 	 Témoins PRE – Ces témoins indiquent le canal sélectionné en conjonction avec le bouton rotatif INPUT.

6. 	 Témoins 48V – Ces témoins indiquent que l'alimentation fantôme 48 volts a été enclenchée dans le 
contrôle logiciel.

 	 Indicateurs 1–8 – Ces indicateurs affichent soit les entrées analogiques soit les sorties analogiques, à 
sélectionner dans le contrôle logiciel.

 	 Indicateurs D1, D2 – L'indicateur D1 affiche la présence d'un signal sur l'un des canaux d'E/S S/PDIF 
Coax, l'indicateur D2 affiche la présence d'un signal sur l'un des canaux des E/S optiques. 

	 Témoins INPUT, OUTPUT – Ces témoins indiquent si les indicateurs affichent les signaux d'entrée ou de 
sortie, tel que sélectionner dans le contrôle logiciel.

 	 Témoins MAIN, Phones 1,2 – Ces indicateurs indiquent la sortie sélectionnée pour modification avec le 
bouton rotatif OUTPUT.

	 Bouton rotatif OUTPUT – Ce bouton contrôle le niveau de sortie sélectionnée tel qu'indiqué par les 
témoins MAIN, hp1 et hp2. Le fonctionnement est similaire à celui du bouton rotatif d'entrée décrit ci-
dessus. Si Main est sélectionné pour Aucun dans le contrôle logiciel, le bouton rotatif n'a aucun effet sur 
les sorties principales.

12	   1,2 – Ces connecteurs TRS fournissent une sortie casque.
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1. 	 MIC1–4 – Ces connecteurs XLR acceptent des entrées micro ou ligne symétriques ; le niveau 
d'entrée est déterminée par le contrôle logiciel.

2. 	 INSERT SEND – RETURN (canaux 1–2) – Ces connecteurs TRS fournissent des points d'insert 
analogiques symétriques avant l'étape de conversion A/N ; l'insertion d'un jack dans la prise 
RETURN active le retour de l'insert. 

•	 L'insert send peut aussi servir de sortie directe : quand seule l'insert send est connecté, le 
signal vers l'étape de conversion A/N n'est pas interrompu.

•	 L'insert return peut aussi servir d'entrée ligne TRS symétrique.

3. 	 HI–Z (canaux 3–4) – Ces connecteurs TRS acceptent les entrées à haute impédance pour les 
canaux 3-4, similaires aux entrées en façade HI–Z.

4. 	 ANALOG INPUT 5–8 – Ces connecteurs TRS acceptent les entrées de niveau de ligne pour les 
canaux 5-8 ; le niveau d'entrée est déterminé par le contrôle logiciel.

5. 	 ANALOG OUTPUT 1–8 – Ces connecteurs TRS acceptent les entrées de niveau de ligne pour les 
canaux 1-8 ; le niveau d'entrée est déterminé par le contrôle logiciel.

6. 	 S/PDIF – Ces connecteurs coaxiaux fournissent les E/S numériques au format S/PDIF.

7. 	 OPTICAL IN/OUT – Ces connecteurs Toslink fournissent les E/S numériques au format S/PDIF, 
ADAT ou SMUX ; le format est déterminé par le contrôle logiciel.

8. 	 FIREWIRE – Ces connecteurs FW 400 fournissent les E/S Firewire vers un ordinateur OSX Apple.
Mode autonome - Si Ensemble ne détecte pas une connexion Firewire valide, il passe en mode 
autonome après un petit moment. C'est indiqué par un témoin rouge (quand la connexion 
firewire est présente mais non-valide) ou vert (quand il n'y a pas de connexion firewire du tout). 
En mode autonome, tous les paramètres de routage, mélange et contrôle faits dans l'unité 
lors de la dernière connexion au Mac sont conservés dans la mémoire flash d'Ensemble, 
permettant par conséquent d'utiliser l'unité lorsqu'elle n'est pas connectée à un ordinateur. Il est 
ainsi possible d'utiliser Ensemble en tant que mélangeur autonome ou convertisseur AN-NA.

9. 	 WORD CLOCK IN/OUT – Ces connecteurs BNC fournissent les E/S word clock.

10. 	WC IN 75 OHM TERM – Ce contacteur coupe l'entrée word clock avec une charge de 75 ohm.

11. 	AC IN – Ce connecteur IEC accepte une entrée CA de 90–250 volts.
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Brancher votre studio

2 Instruments 2 Casques

DVD/CD

Alimenté 
Enceintes

Synthétiseur

Microphones

Configuration de studio de base
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Brancher votre studio

Configuration Surround 5.1

Surround 5.1 
Configuration de 

l'enceinte
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Configuration des applications logiciel audio

Soundtrack Pro d'Apple

Pour sélectionner Ensemble en tant qu'E/S matériel :

1. 	Lecture – ouvrez l'utilitaire Audio Midi Setup (AMS) 
d'OS X, dans le dossier Applications > Utilitaires et 
réglez Sortie par défaut pour Ensemble. 

	 (illustration 24)
 
2. 	Enregistrement – dans Soundtrack Pro, ouvrez 

Fenêtre > Enregistrement et réglez Entrée et 
Dispositif de suivi sur Ensemble. (illustration 25)

Pour contrôler les paramètres d'Ensemble :

1. Dans Maestro d'Apogee, ouvrez Window > Settings.

Final Cut Pro d'Apple

Pour sélectionner Ensemble en tant qu'E/S matériel :

1. 	Lecture – Ouvrez Final Cut Pro > Paramètres Audio 
Video et réglez Lecture audio sur Ensemble. 

	 (illustration 26)

2. 	Enregistrement – Ouvrir Outils > Voiceover et réglez 
Source sur Ensemble. (illustration 27)

Pour contrôler les paramètres d'Ensemble :

1. Dans Maestro d'Apogee, ouvrez Window > Settings.

Configuration d'Ensemble pour son utilisation avec les applications logiciel 
audio

Lors de la configuration d'Ensemble pour son utilisation avec les applications Core Audio, 
il est nécessaire de :

	  1) sélectionner Ensemble dans le menu des pilotes matériel ;
	  2) ouvrir un panneau de configuration logiciel pour contrôler les paramètres d'Ensemble.

illustration 24

illustration 25

illustration 26

illustration 27
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illustration 28

illustration 29

illustration 30

MOTU Digital Performer

Pour sélectionner Ensemble en tant qu'E/S matériel :

1.	Dans Digital Performer, ouvrez Setup > Configurer le 
système Audio > Configurer le pilote matériel.  
(illustration 28)

2.	Réglez Master Device sur Ensemble (illustration 29)
3.	Réglez Work Priority sur Low (illustration 29)

Pour contrôler les paramètres d'Ensemble :

1. 	Dans Maestro d'Apogee, ouvrez Window > Settings.

	

Steinberg Nuendo
Pour sélectionner Ensemble en tant qu'E/S matériel :

1.Dans Nuendo, ouvrez Devices > Device Setup et 
sélectionnez VST Audiobay dans la colonne Devices.  
(illustration 30)

2. Réglez Master ASIO Driver sur Ensemble. (illustration 31)
3. Quand on vous demande “Do you want to select another 

MASTER ASIO driver?”, cliquez sur “Switch”.

Pour contrôler les paramètres d'Ensemble :

1. 	Dans Maestro d'Apogee, ouvrez Window > Settings.

illustration 31
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Dépannage

Le témoin d'alimentation bleu est allumé mais les autres ne le sont pas ; 
l'unité fonctionne-t-elle ?

– Pas encore, quand Ensemble est branché sur le réseau, le témoin d'alimentation 
s'allume faiblement pour indiquer que l'unité est en attente. Pressez l'interrupteur 
d'alimentation pour allumer l'Ensemble.

Comment puis-je rapidement vérifier si le système Ensemble fonctionne correctement ?

– Vérifiez que le témoin STATUS de l'Ensemble est bleu (vérifie l'horloge matériel 
d'Ensemble) ;
– Contrôlez que l'unité apparait dans l'AMS par numéro de série (vérifie la connexion 
audio firewire) ;
– Ouvrez Maestro (ou le Panneau de configuration d'Apogee dans Logic Pro), cliquez sur 
“Identification de l'unité” et vérifiez que tous les témoins s'allument (vérifie la connexion 
du contrôle logiciel par firewire).

Ensemble n'apparaît pas dans mon programme audio ou dans ma configuration 
midi audio.

– Vérifiez que la version requise d'OS X est bien installée
– Le témoin STATUS d'Ensemble est-il bleu ? Dans le cas contraire, rebranchez le câble 
Firewire ou remplacez-le.

Je ne peux contrôler Ensemble avec Maestro ou le Panneau de configuration Apogee de 
Logic Pro.

– Vérifiez la présence de ce fichier : System > Library >Extensions > apogfwplugin.
bundle. Si vous ne le trouvez pas, réinstallez le logiciel à partir du CD inclus dans 
Ensemble.

Il n'y a aucun signal sur les sorties analogiques 1-2.

– Ouvrez Maestro, réglez Meter Display sur Output et vérifiez qu'un signal est 
affiché sur les indicateurs. Si vous n'appréciez aucun signal, vérifiez le routage depuis 
l'application audio logiciel. Si le signal s'affiche sur les indicateurs mais n'est pas présent 
aux sorties analogiques 1-2, vérifiez que le niveau de sortie MAIN est correct (dans 
Maestro ou à l'aide du bouton OUTPUT en façade).

La bouton OUTPUT en façade n'attenue pas le signal des sorties analogiques 1-2.

– Quand Sélection du format est réglé sur Aucun (dans Maestro), le bouton OUTPUT 
en façade n'attenue pas le niveau de sortie. Réglez Sélection du format sur Stéréo.

Les indicateurs ne fonctionnent pas du tout.

– Vérifiez que les paramètres METER dans le Panneau de configuration Apogee de 
Logic ne sont pas sur OFF.
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Je veux lancer Ensemble à 176,4 –192 kHz, mais je ne vois que 44,1–96 kHz dans AMS.

– Ensemble peut fonctionner à des fréquences d'échantillonnage de 44,1 à 96 kHz ou 176,4 à 
192 kHz, selon le paramètre de la Plage de fréquences d'échantillonnage dans le panneau 
Paramètres Maestro d'Apogee. Pour changer la plage de fréquences d'échantillonnage, ouvrez le 
panneau Maestro>Fenêtre>Paramètres et réglez la Plage de fréquences d'échantillonnages 
sur le paramètre désiré. Lorsque vous configurez la plage, fermez toutes les applications audio et 
laissez 30 secondes pour qu'Ensemble se relance à la nouvelle plage.

J'essaye de verrouiller Ensemble sur une source externe mais le témoin STATUS n'arrête 
pas de clignoter.

- Quand Ensemble est verrouillé sur une source externe, la fréquence d'échantillonnage 
d'Ensemble est toujours déterminée par la sélection dans le logiciel. Par conséquent, la fréquence 
d'échantillonnage de la source externe doit être configurée manuellement pour correspondre à 
celle du logiciel. Par exemple, si vous souhaitez ouvrir une session à 88,2 kHz mais que vous 
verrouillez Ensemble sur la word clock d'un Big Ben Apogee, vous devez régler manuellement le 
Big Ben sur 88,2 kHz.

Comment dois-je faire pour réinitialiser Ensemble à ses paramètres par défaut ?

– Ensemble peut être réinitialisé en pressant le bouton gauche en façade puis en allumant l'unité ; 
maintenez le bouton enfoncé lors de la séquence d'initialisation.
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Avertissements & Droits d'auteur

Avertissement FCC
Cet équipement a été testé et s'est avéré conforme aux limites pour la classe A des appareils numériques, selon les 
termes de la partie 15 des règles FCC. Ces limites sont conçues pour offrir une protection raisonnable contre les 
interférences dommageables dans une installation domestique. Cet équipement produit, utilise et peut entraîner un 
rayonnement d'énergie de fréquence radio et, s'il n'est pas utilisé conformément aux instructions, peut causer des 
interférences dommageables au communications radio. L'utilisation de cet équipement dans une zone résidentielle 
peut provoquer des interférences dommageables, dans ce cas l'utilisateur devra prendre les mesures nécessaires pour 
corriger ces interférences à ses frais.

Remarque sur le droit d'auteur
L'Ensemble d'Apogee est un dispositif informatique et à ce titre contient et utilise des logiciels sous forme de ROM. 
Ce logiciel et toute la documentation connexe, ce manuel inclus, contiennent des informations propriétaires qui 
sont protégées para les lois sur le droit d'auteur. Tous les droits sont réservés. Aucune partie de ce logiciel et de sa 
documentation ne doit être copiée, transférée ou modifiée. Vous ne pouvez pas modifier, adapter, traduire, louer, 
distribuer, revendre ou créer des travaux dérivés en vous basant sur ce logiciel ou la documentation connexe, tout ou 
partie, sans un consentement préalable écrit d'Apogee Electronics Corporation, U.S.A.

Remarque sur le logiciel
La redistribution ou l'utilisation de la source ou des binaires, avec ou sans modification, sont permises dans les conditions 
suivantes :

•	 Les redistributions du code source doivent conserver la note sur le droit d'auteur précédente, cette liste de conditions 
et l'avertissement suivant.

• 	 Les redistributions sous forme binaire doivent reproduire la note sur le droit d'auteur précédente, cette liste de 
conditions et l'avertissement suivant dans la documentation et/ou dans les autres matériaux fournis avec la 
distribution.

CE LOGICIEL EST FOURNI PAR LES DÉTENTEURS DU DROIT D'AUTEUR ET LES CONTRIBUTEURS "TEL QUEL" 
ET LES GARANTIES EXPRES OU IMPLICITES, INCLUANT, SANS LIMITATION, LES GARANTIES IMPLICITES 
DE VALEUR MARCHANDE ET D'ADÉCUATION À UN BUT PARTICULIER SONT NIÉES. DANS AUCUN CAS, LE 
DÉTENTEUR DU DROIT D'AUTEUR OU LES CONTRIBUTEURS NE SONT RESPONSABLES POUR LES DÉGÂTS 
DIRECTS, INDIRECTS, ACCIDENTELS, SPECIAUX, EXEMPLAIRES OU CONSECUTIFS (INCLUANT, SANS 
LIMITATION, L'ACQUISITION DE BIENS CONNEXES OU DE SERVICES ; LA PERTE DE L'USAGE, DE DONNÉES 
OU DE PROFITS OU UNE INTERRUPTION COMMERCIALE) PROVOQUÉS TOUTEFOIS ET TOUTE THÉORIE DE 
RESPONSABILITÉ, QUE CE SOIT PAR CONTRAT, RESPONSABILITÉ STRICTE OU PRÉJUDICE (NÉGLIGENCE ET 
AUTRE INCLUS) PAR L'UTILISATION DE CE LOGICIEL, MÊME APRÈS AVOIR ÉTÉ AVERTI DE LA POSSIBILITÉ DE 
TELS DÉGÂTS.
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Déclaration de conformité — FCC

Apogee Ensemble
Ce dispositif est conforme à la partie 15 du FCC Rules. Le fonctionnement est soumis aux deux conditions suivantes : 
(1) Ce dispositif ne doit pas provoquer d'interférence dommageable
(2) Ce dispositif doit accepter les interférences reçues, même celles qui pourraient provoquer un fonctionnement non désiré.
Cet équipement a été testé et s'est avéré conforme aux limites pour la classe B des appareils numériques, selon les termes 
de la partie 15 des règles FCC. Ces limites sont conçues pour offrir une protection raisonnable contre les interférences 
dommageables dans une installation domestique. Cet équipement produit, utilise et peut entraîner un rayonnement d'énergie 
de fréquence radio et, s'il n'est pas utilisé conformément aux instructions, peut causer des interférences dommageables au 
communications radio. Si cet équipement produit en effet des interférences dommageables à la réception radio ou télévisuelle, 
ce qui peut être établi en éteignant et rallumant l'équipement, l'utilisateur est encouragé à essayer de corriger les interférences 
en appliquant les mesures suivantes :
1. Réorientez ou déplacez l'antenne réceptrice.
2. Augmentez la séparation entre l'équipement et le récepteur.
3. Connectez l'équipement sur une prise appartenant à un circuit différent de celui auquel le récepteur est connecté.
4. Consultez le vendeur ou un technicien expérimenté dans le domaine radio/TV pour obtenir une assistance.
REMARQUE : L'utilisation d'un câble non-blindé avec cet équipement est interdite.
ATTENTION : Les changements ou les modifications non expressément approuvés par le fabricant peut annuler le droit de 
l'utilisateur à utiliser cet équipement.

Apogee Electronics Corporation, 1715 Berkeley St, Santa Monica, CA 90404. 
Betty Bennett, CEO.

Note pour le Canada

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada. Cet 
appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Déclaration de conformité – CE

Apogee Electronics Corporation déclare par la présente que ce produit, l'Ensemble, auquel ce document fait référence, est un 
matériel en conformité avec les standards et normes suivantes :
• EN50081–1/EN55022; 1995
• EN50082–1/IEC 801–2, 3, 4; 1992
suivant les dispositions de :
• 73/23/EEC – Low Voltage Directive
• 89/336/EEC – EMC Directive

Déclaration de conformité – Japon

Apogee Electronics Corporation déclare par la présente que l'Ensemble, auquel ce document fait référence, est un matériel en 
conformité avec le standard de Classe A VCCI.

Déclaration de conformité – Australie

Apogee Electronics Corporation déclare par la présente que l'Ensemble est un matériel en conformité avec le standard AN/NZS.

Déclarations de conformité
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Assurez-vous d'enregistrer votre Ensemble, que ce soit en remplissant la Carte d'enregistrement ou en remplissant le 
formulaire d'enregistrement en ligne sur notre site web : http://www.apogeedigital.com/support/. Dans ce cas, Apogee peut 
vous contacter avec des informations de mise à jour. Au fur et à mesure que des améliorations et des mises à jour sont 
développées, vous serez contactés à l'adresse d'enregistrement. Les mises à jour du Firmware sont gratuites pendant un 
an, sauf mention contraire. Veuillez envoyer vos questions à votre revendeur ou directement à Apogee à :

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St, Santa Monica, CA 90404, USA. 
TEL : (310) 584–9394 ; FAX : (310) 584–9385
Email : support@apogeedigital.com. Web: http://www.apogeedigital.com/

APOGEE ELECTRONICS CORPORATION garantie ce produit sans défaut en matériaux et construction pour un usage 
normal pendant 12 mois. Les termes de cette garantie commencent à partir de la date de vente. Les unités retournées 
pour une réparation sous garantie à Apogee ou un centre de réparation autorisé seront réparées ou remplacées au choix 
du fabriquant, sans frais. 
TOUTES LES UNITÉS RETOURNÉES À APOGEE OU UN CENTRE AGRÉÉ DOIVENT ÊTRE PRÉPAYÉES, 
ASSURÉES ET CORRECTEMENT EMABALLÉES, SI POSSIBLE DANS LEUR BOÎTE D'ORIGINE. Apogee se réserve 
le droit de changer ou d'améliorer la conception à n'importe quel moment et ce sans préavis. Les modifications de 
conception ne sont pas incorporées rétroactivement et l'incorporation des modifications de conception dans les unités 
futures n'impliquent aucune mise à jour des unités existantes.

Cette garantie est annulée si Apogee détermine, à son seul jugement, que le défaut est le résultat d'abus, de négligence, 
d'altération ou de tentative de réparation par un personnel non agrée. 

Les garanties ci-présentes remplacent toutes les garanties, exprès ou implicites, et Apogee nie spécialement toutes 
garanties implicite de valeur marchande ou d'adéquation à un usage spécifique. L'acheteur reconnait et accepte que la 
compagnie ne pourra être tenu responsable de tout dégât spécial, indirect, accidentel ou consécutif ou de toute blessure, 
perte ou dégât sur une personne ou un bien, qui pourrait résulter du disfonctionnement de ce produit. 

Certains états n'autorisent pas l'exclusion des garanties implicites ou des limitations dans la durée d'une garantie implicite, 
par conséquent les limitations ci-dessus ne s'appliquent pas à vous. Vous pouvez disposer d'autres droits qui varient d'un 
état à l'autre. 

Information sur la maintenance

L'Ensemble contient des composants qui ne peuvent être entretenus par l'utilisateur : contactez un personnel qualifié pour 
toute réparation ou mise à jour. Votre garantie sera annulée si vous manipulez les composants internes. Si vous avez des 
questions concernant les normes décrites, veuillez contacter Apogee. 

Dans le cas où votre Ensemble requiert une mise à jour ou une réparation, il est nécessaire de contacter Apogee avant 
l'expédition. Un numéro Return Materials Authorization (RMA) vous sera affecté. Ce numéro vous servira de référence et 
facilitera le retour. Apogee requiert que les expéditions soient prépayées et assurées - sauf mention contraire négociée à 
l'avance. 

IMPORTANT : TOUTE EXPEDITION NON PRÉ-PAYÉE OU SANS NUMÉRO RAM NE SERA PAS ACCEPTÉE. 

Informations sur l'enregistrement et la garantie
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